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Migration guide SYSTEMS

Migrating from Keil pVision® for 8051 to IAR Embedded Workbench® for 8051

Use this guide as a guideline when converting project files from the pVision IDE and source code written
for Keil toolchains for 8051 to IAR Embedded Workbench for 8051.

Product Version number
Migrating from Keil pVision IDE (C51 compiler) V4.x
Migrating to IAR Embedded Workbench for 8051 V9.30 and newer

Migration overview

Migration of an existing project from Keil pVision requires that you collect information about your current project and then
apply this information to the new IAR Embedded Workbench project. In addition, you need to make some changes in the actual
source code. The information in this guide simplifies this process.

Getting Starged
Note: Basic introduction to IAR Embedded Workbench and how to work in the IDE can be g
found in the guide Getting Started with IAR Embedded Workbench available in the Information ~
Center and in the tutorials. w

Project conversion

To migrate existing Keil pVision applications to IAR Embedded Workbench there is a tool called Convert To IAR. This is a
GUI application included with IAR Embedded Workbench, available via the Tools menu.

The Convert To IAR tool converts pVision 4 project r@. Convert To IAR (i) |
files into AR Embedded Workbench project files
without changing the original file. Information about

Root directory of source project

source files, include paths, defined symbols, and build CWel\CoT Pxamples BLINGY E
configuration is transferred. As an option, also source Project file conversion
code substitutions are performed and you can add your [F]Enable
own substitution rules including support for regular Project type
expressions. There are a number of pre-defined [eil uvision4 for 8051 -
substitution rules. File extension(s)
= uvpraj
Procedure
1. Start IAR Embedded Workbench. Source code substitution
2.  Start Convert To IAR available in the Tools []Enable
menu. Substitution rules
3. Navigate to the uVision project to convert by Nea|sEram To - Add
clicking the browse button. E
4.  Click the Execute button and a new IAR 2 (h+")data(e+I\710)  $1_datas2
Embedded Workbench project file will be i x:::gf::;ﬁj::m) :_f;:;;
created. 5 (h+]“bdata(ls+[\[Y) &1 bdatasa
5. Add the new project to a workspace by i ﬂﬁ;':&f;:[;i‘j;‘” :;‘;rdn:fi s
choosing Add Existing Project in the Project 8 AN([azAZ05 14... \népraqma eor “The .. ™ Export
menu. Perform substitutions on file(s) with extension(s)
6. Set the relevant project options by choosing [‘.c;‘.q:ﬂ:l;‘.h;*.hpp v]
Options in the Project menu.
Hint: Open the original project in pVision, [ cese | [ Exec= |

walk through the options and set the L
corresponding options in IAR Embedded
Workbench as suggested in the section

Important tool settings below.
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Basic code differences

The following sections show some of the basic differences between code written for the Keil toolchain and IAR Embedded
Workbench that you should handle before building your converted project.

Initialization code

In IAR Embedded Workbench, initialization code is primarily located in the file cstartup.s51.

This file contains system startup code executed after reset, but before the main () function is called. Data/segment
initialization, stack pointer initialization and other things are performed here. This code is part of the runtime library but can be
overridden by including a copy of this assembler file in your project. You find the file in the folder 8051\ src\1ib in the
TAR Embedded Workbench installation.

The function int _ low_level init (void) iscalled from cstartup.s51. Its purpose is to perform any hardware
initialization required before segment initialization and calling main (). You may include your own version of this function in
your project by adding a copy of the file low level init.c, located in the folder 8051\src\1ib, and edit it according
to you needs.

Special Function Registers

Each device supported by IAR Embedded Workbench has its own header file that contains variable definitions to access the
SFRs of the device, both for C/C++ and assembler. The naming convention for these header files is 1iodevice-name.h and
they are located in 8051\ inc.

Example: 10EFM8SB20F64G.h

The names of SFR variables might sometimes differ from the names used in the Keil toolchain. SFR bit access differs because
IAR Embedded Workbench does not support the sbit keyword which is commonly used in the Keil toolchain for the purpose
of defining variables to access specific SFR bits. Instead, a C st ruct where each member represents one or more bits is used
for this purpose. This struct is named SFR-name bit, where SFR-name is the name of the corresponding SFR variable
represented as a byte.

Sometimes several SFR bits, which are semantically related within the same SFR, are represented by separate sbit variables
in the Keil toolchain while they can be combined into a single bit-field in IAR Embedded Workbench. This can make it
necessary to rewrite source code which manipulates such bits or define your own variables to access the bits separately.

The  sfr memory type attribute keyword is used in IAR Embedded Workbench to define/declare SFR variables, for example
as follows:

__sfr no_init volatile unsigned char TLO @ Ox8A;

To define a variable which represents an SFR which consists of two bytes there is no special keyword like sfr16 which is
used in the Keil toolchain. The same keyword is used but the variable has the type unsigned short instead of unsigned
char:

__sfr no init volatile unsigned short ADCO @ O0xBD;

The same restrictions as in the Keil toolchain apply when using this type of variable, the low byte should immediately precede
the high byte address wise and the low byte is the address of the variable. There is one difference though, when writing to the
variable Keil writes the most significant byte first and the least significant byte last while JAR Embedded Workbench writes
them in the opposite order. Generally, the writing order of SFRs can affect the hardware behavior so care must be taken when
utilizing multi-byte SFRs.

Interrupt Service Routines

The interrupt keyword is used in the Keil toolchain when defining an interrupt function (ISR). In IAR Embedded
Workbench, the extended keyword __interrupt is used for the same purpose. The interrupt keyword has a numeric
parameter which the Keil compiler automatically translates into an interrupt vector number. IAR Embedded Workbench
requires the application developer to specify the vector number directly using the vector pragma directive. For convenience,
the device-specific header file containing the SFR access variables also contain defined names for the interrupt vectors. Here is
an example comparing the syntax used in the two toolchains:
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Keil toolchain IAR Embedded Workbench
#pragma vector=0x0B
void timer0 isr(void) interrupt 1 __interrupt void timer0O isr(void)

{ {

It is also possible to specify a register bank which will be used by an interrupt function. In the Keil toolchain, this can be done
for any function, but in JAR Embedded Workbench it is only applicable to interrupt functions. The using keyword is used in
the Keil toolchain whereas the register bank pragma directive is used in IAR Embedded Workbench. Here is an example:

Keil toolchain IAR Embedded Workbench

#pragma register bank=2

fpragma vector=0x0B
void timerO isr(void) interrupt 1 using 2 __interrupt void timer0 isr(void)
{ {
} }
Inline assembler
Inline assembler is handled somewhat differently in the Keil toolchain than in IAR Embedded Workbench. The Keil toolchain
provides mechanisms to insert assembler code only if configured to generate a separate assembler source file (. src) which is
then assembled to object code. IAR Embedded Workbench integrates the assembler code directly into the object code when
compiling, but of course it is possible to generate a separate assembler source file (. s51) if desired.
The mechanism used in the Keil toolchain are the pragma directives ASM and ENDASM (or the alternative keyword  asm).
There are no corresponding pragmas in IAR Embedded Workbench, the asm keyword (or its alias  asm) is used instead.

Note that asm in the Keil toolchain does not have the same syntax or semantics as ___asm in JAR Embedded Workbench.
Here is an example of two equivalent code sequences:

Keil toolchain IAR Embedded Workbench
#pragma ASM
MOV A, #33H __asm("MOV A, #0x33\n"
MOV R1, #22H "MOV R1, #0x22\n"
ADD A, R1 "ADD A, R1\n"
JMP $ "JMP $");

#pragma ENDASM

Managing memory

The memory models used in the Keil toolchain — which can be applied to functions, constants and variables — correspond to the
concepts of code model and data model in IAR Embedded Workbench. The code and data models are set per project and
specify the default storage model for functions and data respectively. The code model can be overridden for individual
functions using function memory attribute extended keywords in the source code. The data model can be overridden for
individual data objects or pointers by specifying data memory attribute extended keywords in the source code. The data
memory attributes correspond to memory type specifiers in the Keil toolchain.

Data with an integer type represented by more than one byte is stored as big endian in the Keil toolchain. In AR Embedded
Workbench such data is stored as little endian. This fact might require source code to be rewritten to work as expected.

Many library functions declared in string.h (such as memcpy, memcmp, strcat etc.) cannot handle parameters which are
located in different memory types. This might cause unexpected results.

Bit variables

Declaring a single-bit variable (which will be located in the bit-addressable area of the internal RAM) is done in the Keil
toolchain using the type bit. In IAR Embedded Workbench, this is accomplished by declaring a variable which has the type
bool in combination with the __ bit data memory attribute. A declaration using the __bit attribute has limitations; it must be
located outside the function scope, and the object attribute  no_init must also be used which means that such a variable cannot
be initialized at the same time it is declared. If, in code written for the Keil toolchain, a variable declared with the bit keyword
resides within a function, a function argument list, or if a function returns a value of type bit, a supported type such as boo!
should be used in IAR Embedded Workbench.
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Variables previously declared using the type bit have another type in IAR Embedded Workbench. Therefore they are no longer
bit-oriented and references to such variables should be reviewed carefully because bit-oriented operators such as ~, *, & and |
will most probably not have the same effect after the change of type.

Building your project

After successfully converting the Keil pVision project and considered the basic code differences described above, you will still
most likely need to fine-tune parts of the source code so that it follows the IAR Embedded Workbench syntax.

1. Select your device under Project>Options>General Options.

2. Choose Project>Make.

3. To find the different errors/warnings, press F4 (Next Error/Tag).
This will bring you to the location in the source code that generated this error/warning.

4. For each error/warning, modify the source code to match the IAR Embedded Workbench syntax.
Note: You might have to consult the IAR C/C++ Compiler User Guide for this step.

5. After correcting one or more errors/warnings, repeat the procedure.

Note: It is always a good idea to start by correcting the first couple of errors/warnings in different source files because errors
and warnings later in the source code might just be effects of faulty syntax at the beginning of the source code.

Important tool settings

This is an overview of the most important tool settings. Note that many settings do not have a one-to-one mapping. An example
is the memory segment configuration which is available in Keil pVision through the Options dialog box. In IAR Embedded

Workbench segment configuration is all done in the linker configuration file which can be pointed out in the Options dialog
box.

Keil pVision IAR Embedded Workbench
Device selection
K Options for Target 'Simulator' @ Options for node "projectl” Ié
Target | Output | Listing | User | C51 | A51 | BL5T Locate | BL51 Misc | Debug | Utilties |
Database: |Generic CFU Data Base - Categary.
Uiy TenlEirEmT i
Static Analysis
Device: CB0STFD15 I~ Use Extended Linker (LX51) instead of BL51 I+ + Compler
Toolset: C51 = Assembler Target | Stack/Heap | Data Pointer | Code Bank | Output | Library Cor * | *
%% Silcon Laboratories, Inc. _ » |25 MIPS mixed-signal, 32K in-system programmable a suff:’f”“d Device information
£3 Ca051F000 FLASH 8051 with 256 bytes RAM: 2K-bytes XRAM: uild Actions
€3 caosiFont SPI; SMEus/12C; UART: 10bt & channel A/D; Linker Device: CB051F015
| |12+t 2-channel D/A; 2 voltage comparators: Debugger
€ consiFoce o <hip temperere sensar: 4 mers: PCA : CEU core:
£3 caos1Fo0s Third-Party Driver
g e
: . e
£3 Cs051F010 Infineon Near - Use extended stack
£3 caosiFon Segger J-Link
£1 caos1Foi2 Nordic Semicondu || D22 mode! Caling convertian
£3 Ce051F015 ROM-Maritor [smal »]  [IDATAstack reentrant -]
£3 caosiFois
g C2051F017 :Tah\ug Devices Location for constants and strings
£1 conniEme o = s‘a fm Number of virtual registers @ RAM memary
F N F— T — q b imuEtor ") ROM mapped as data
Use MDU ) CODE memory
oK Cancsl Defauits Help
L

Default memory model
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-
Options for Target 'Simulator’

Device | Targel | Outout | Listing | User | C51

==)

-
Options for node "project1”

Silicon Laboratories, Inc. C8051F015

| A51 | BLS1 Locate | BLST Misc | Debug | Utities |

Hal (MHz): 200 [~ Use On-chip ROM (T0-Bx7FFF)
Memory Model: |Small: variables in DATA hd
Code Rom Size: |Large: 64K program ~| T Use On-chip XRAM ((0-E7FF)
Operating system: |None hd
~Offchip Code memory - Off-chip Xdata memory
Start, Size: Start Size:

[~ Code Banking

Barks: |2

Start

Bank Area: |(<0000 IW

End: ™ 'far’ memory type support

I Save address estension SFR in intermupts

[ o 1|

Cancel | Defaults

Help

Categoy

Static Analysis
CfC++ Compiler
Assembler
Custom Build
Build Actions
Linker
Debugger
Third-Party Driver
Texas Instrumenty
F52 System Mavig
Infineon
Segger J4ink
Nordic Semiconduc
ROM-Manitor
Analog Devices
Silabs
Simulator

Target | Stack/Heap | Data Pointer | Code Banik | Output | Library Cor

ae

Device infomation

Device CEOS1FO15
CeU core
Code model
Mear - Use extended stack
Data mods! Caling convertion
[smal ~] [IDATAstackreentent  ~|

Location for constants and strings
RAM memory

ROM mapped as data
CODE memory

Number of virtual registers:

Use MDU
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Keil puVision
Output type

-
Options for Target ‘Simulator’

IAR Embedded Workbench

=
Options for node “project1”

Select Folder for Objects Name of Exscutable: |BLINKY

Categary;

% Create Executable: \BLINKY

[V Debug Information [V Browse Information

™ Create HEX File HEX Format: |HEX-80 2

" Create Library: \BLINKY.LIB I Create Batch File

Static Analysis
CfC++ Compiler

Assembler
Custom Build

| Target | StacksHeap | Data Pointer | Code Bank | Ottput | Library Car [ *

Build Actions
Linker
Debugger

Third-Party Driver
Texas Instruments
F52 System Mavig
Infineon
Segger J-Link
Nordic Semiconduc
ROM-Monitor
Analog Devices
Silabs
Simulator

Output directories
Executables
Debug'\Exe

Obiject files:

List files:
Debug®List

Cancel Defaults

Output format

-
Options for Target ‘Simulator’

SPROJ_FNAMES\Debug\Obj

Device | Target 1

Listing | User | C51

=
Options for node “project1”

[E=)

| A51 | BL51 Locate | BL51 Misc | Debug | Utities |

Select Folder for Objects Name of Executable: |BLINKY

% Create Exscutabls: \BLINKY

[V Debug Information [V Browse Information

™ Create HEX File HEX Format: |HEX-20 -

" Create Library: \BLINKY LIB

I Create Batch File

Categary;

General Options
Static Analysis
CfC++ Compiler

Factaory Settings

Assembler
Custom Build

ig | Output | Bra Output |

List | Log | #define | Diagnostics| * [ *

Build Actions

project1.d51

Debugger
Third-Party Driver
Texas Instruments
F52 System Mavig

Format

ebug information for C-SPY
With puntime cortrol modules

Infineon ith /0 emulation modules

Segger Idink Buffered temminal output

Nordic Semiconduc [C] AMllow C-5PY-specific extra output file
ROM-Moritor Other

Analog Devices - Output formal: |intel-extended
Silabs Farmat variant | None

Simulator

Secondary output file:
{Mone for the selected format)

Cancel Defaults

Moduledocal symbols:  [Include all

Compiler options

-
Options for Target 'Simulator’

Device | Target | Output | Listing | User

=
Options for node "project1”

| A51 | BL51 Locats | BL51 Miso | Debug | Liities |

F Symbols

Define: |
Undsfine |

r~ Code Oy

Wamings: [Waminglevel 2
Level I 8: Reuse Common Entry Code

Emphasis: [Favorspeed  ~| [ Global Register Coloring

I™ Linker Code Packing [man. &JMP / ACALL]

Bits to round for float compare: |3 -
I Intemupt vectors at address |1:M}GDD

I™ Keep variables in order

=l

[~ Dont use absolte register accesses

[V Enable ANS integer promotion nules

Include

Paths

Misc I
Controls

L]

Compiler
control
sting

BROWSE DEBUG OBJECTEXTEND TABS (2)

Categary;

General Options
Static Analysis
-+ Compiler

[ Multi-file Compilation

Diseard Unused Publics

Factory Settings

Assembler Language 1 | Language 2 | Code

[o | Output [ List

Custom Build

|,4 3

Build Actions
Linker
Debugger
Third-Party Driver
Texas Instrumenty,

Cav
F52 System Navig, Auto {extension-based)
Infineon
Segger J-Link C dialect
Nordic Semicondu © a9
ROM-Monitor 3 C99
Analog Devices [ Mlow VLA
Silabs [ C++inline semartics
Simulator

[T Require prototypes

OK I Cancel Defaults

Language conformance
@ Standard with |AR extensions

Ce+dizlect

Embedded C++
Extended Embedded C++

Destroy static objects
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Keil pVision

Defined symbols and include directories

IAR Embedded Workbench

™ Dont use absolute register accesses

™ Keep variables in order

[V Enable ANSI integer promotion nulss

Include I
Paths
Misc

B

Cortrols

Compiler
control
sting

BROWSE DEBUG OBJECTEXTEND TABS (2)

Third-Party Driver
Texas Instrumenty
F52 System Mavigi
Infineon
Segger Jink
Nordic Semiconduc
ROM-Manitor
Analog Devices
Silabs
Simulator

r A r a
Options for Target ‘Simulator’ u Options for node "project1” g
Device | Target | Output | Listing | User [CBT | A1 I BL51 Locate | BL51 Misc | Debug | Utilitiesl
P Symbols Ctzny Factory Settings
Define: | General Optians [ Multiile Compilation
Static Analysis Discard Unused Publics
Ut |
Assembler [ Language 2 | Code | Optimizations [ Output [ List | Preprocessor L
r~ Code Oy
Wamings: [Wamingievel 2 = Custom Euld (& )
Level: | 8 Reuse Commen Entry Code -] Buid Actions i
] = Bitsto round forfloat compare: [3 <] Linker Additional include directories: (one per line)
Emphasis: |Favorspeed v Global Register Coloring R o IW Debugger
I Linker Code Packing [max. AJMP / ACALL)

- [

Preinclude fils:

Defined symbols: (one per ing)
- [ Preprocessor output to file
Preserve commets
Generate Hine directives

0K I Cancel Defaults Help
Linker options
r M r N
Options for Target 'Simulator’ u Options for node "projectl”™ g
Device | Target | Output | Listing | User | C51 | As1  [BLST Locate | BL51 Misc | Debug | Ltiities |
[¥ Use Memory Layout from Target Dialog Category
Code Range: I General Options
B Static Analysis

Space  Base Segments: Xdata Range: I C/C++ Compiler

Code [ Assembler Corfig | Output | Bara Output | st [ Log [ #define | Diagnosties| * | *
Ce Custom Build Linker e

Xdata I Build Actions [

Pdata: STOOLKIT_DIRS\config\devices'Silicon LabsInk51ew_C805

Precede: I Third-Party Driver

g Texas Instrument:
B I I FS2 System Mavig| [T]Overide defautt program entry
Data | | Infineon (@) Entry symbol |_program_start

Segger JHink Defined by application

Idata I I Nordic Semicondu| Search paths: (one perline)
Stack: | ROM-Manitor STOOLKIT_DIRSMLIBN - &

T Analog Devices -

inker T . b :
control ;iM?I_g;gHE] Silzbs Raw binary image
string < Simulator File Symbol  Segmert:  Align
oK I Cancel Defaults Help

Note: We recommend that you verify all settings to make sure they match your project requirements.

IAR, IAR Systems, IAR Embedded Workbench, C-SPY, C-RUN, C-STAT, visualSTATE, Focus on Your Code, IAR

KickStart Kit, IAR Experiment!, I-jet, I-jet Trace, I-scope, IAR Academy, IAR, and the logotype of IAR Systems are
trademarks or registered trademarks owned by IAR Systems AB.

All information is subject to change without notice. IAR Systems assumes no responsibility for errors and shall not
be liable for any damage or expenses.

© 2016 IAR Systems AB. Part number: EW8051_MigratingFromKeil-2. Second edition: January 2016
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